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Frequently Asked Questions

This document addresses how to use Reserved Net Conference with Cisco WebEx Event Center service — from scheduling a
Reservation, to confirming or changing a reservation and ultimately to hosting an event.

1. How do | obtain a Manage My Meetings account?

Follow the steps below to register and begin using today!
e Goto https://lwww.mymeetings.com/custom/site/mymeetings/index.jsp

e  Click on Register for audio/net/video
Click Yes to proceed.
e  Create your leader profile:

0 Select alogin name

0 Select a password or let the system create one for you

0 Set a security question and answer

o0 Complete the fields on the page with your information details

0 Authorization code: your conference administrator will provide this to you

o Click Proceed
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2. How do | schedule a call?

You will need to schedule the Reserved Net conference with a Premier or Standard audio conference, via either
the Conferencing Scheduling Assistant (CSA) tool or by calling Reservations.

e Conferencing Scheduling Assistant:
o Goto https://www.mymeetings.com
0 Goto Leader Tools and click on Conferencing Scheduling Assistant
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e Calling Reservations
o https:/lwww.mymeetings.com/custom/res/content/resNumbers.php
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3. Confirmation Email

e Once the leader schedules the meeting, they will receive an email confirmation with the details of the event
which they can share with their participants.

e  See higlighted sections below for the Reserved Net Conference portion of the email confirmation.
Sample Reserved Net Email Confirmation:
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Your conference details are enclosed.
Meeting Information:

Leader: VERIZON TESTMK
Phone number:  1-610-555-XXXX
Contact: VERIZON TESTMK

Phone number:  1-610-555-XXXX

pervice level:  Premier

Number of lines: Total=10 Dialout=0 Meet Me=10 Meet Me Toll=0
[Call date: DEC-25-2013 (Wednesday)

Call time: 09:00 AM CENTRAL TIME

Duration: 1 hr

Confirmation number: 10000XX

Company: REDESIGN TESTING

CRC: 2g99

Passcodes/Pin codes:
Participant passcode: 286XXXX
For security reasons, the passcode will be required to join the conference.

Dial in numbers:
Country Toll Numbers Freephone/Toll Free Number

IJSA B83-X0(X-)0(X

Restrictions may exist when accessing freephone/toll free numbers using a mobile telephone.

WebEx(TM) Net Conference Access Information:

For Leaders:

]A Leader caninitiate the event directlyvia Manage My Meetings using their Login and Password. Upon access, select the
Reserved Audio Calls' tab and click on the START icon to launch your Net Conference and share your documents.

The Net portion of your call can be accessed 30 minutes prior to its scheduled start time.

f you have questions about sharing your documents, please go to
https: //www.mymeetings.com/docMer/get/www.custom.content.docs.event CenterlUserGuide ciscowebex mymeeting
b 060112 pdf or contact Reservations.

For Participants:

URL: https://www.mymeetings.com/vcpdemo/join/
Conference number: PWXXOX0XXX

Budience passcode: 286X00(X

Participants can join the event directly at:
https: _mymeetings com/nc/joinphp?i=PW XXXX

To access the Net replays of this call, all parties may join at:
https: .mymeetings.com/nc/join.php?i=PWXXXXXX= 286 XX XX =r&si =y m
NOTE: You will receive an e-mail with instructions on how to download your Net Recording (FTP).

NOTE: The replay and/or FTP download of this conference is available in an Advanced Recording File (ARF) format
and requires the WebEx Recording Player to be viewed.

The Player is available from the Conferencing portal under Leader Tools = *Net Conferencing Plug-Ins.

Confirmation email continued:
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'To access the Net Participant List for this event, please click
https://www.mymeetings.com/custom/redirect.jsp?referer=/ss/r.php?c=1640230&h=e&i=XXXXXX and then complete
the following:

1. Enter your Manage My Meetings Login and Password

2. Select ‘Participant List Reports’ from the Self-Service Reports page

3. Select the report you wish to display — Net Conference — and select ‘View Report’
4. You can then download or print your report

NOTE: The information presented is listed just as the participants entered it into the various fields, when joining
conference.

For enhanced security and to avoid continued billing post-conference, please disconnect all participants at the end of
the net conference by selecting "End Event" under the "File" menu.

Instant Replay Plus Information:

Replays are generally available one hour after a call ends.
End date: DEC-26-13 09:00 AM (CT)

Phone: Toll: 203-XXX-XXXX

Passcode: 12345

Features:

Selected Conference Features:

Audio:

Music On Hold Roll Call

Listen Only Announce Late Parties
Secured Conference Conference Monitor
Q&A Participant Screening
Polling Subconferencing

Net Conference Conference Recording
Transcription Tape Playback
Meeting Manager Meeting View

Net:

Net Participant List, Net Replay (Duration 30 days ending JAN-24-2014)

Conference Recording Information: (This section of the email confirmation applies to the audio recording only.)

Recording will be available for 30 days 1 hour after the call is completed.
Click the link below to access your downloadable file.

Recording Type DOWNLOAD

Leader URL:
https://www.mymeetings.com/custom/redirect.jsp?referer=/mm/ims/d.php?0=164XXXX&sigKey=vcpdemo (do not
forward)

After downloading and saving the recording, leaders can distribute the file to participants.
One download per recording only.

Confirmation email continued:
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Transcription Information:

E-mail: MEL.KRAN @XXX.COM
Conference Language: ENGLISH
Email Turnaround Time: 48 hr

*Transcription will be in the conference language.

Meeting Manager Information:

A Meeting Manager will contact you shortly to discuss the details of your call. If you have requested a particular Meeting
Manager, we will do our best to accommodate your needs. Unfortunately, special requests cannot always be granted
due to conflicting meeting times.

Participant List Information:

Send To: VERIZON TESTMK

Conference Coordinator Will Capture: NAME

Comment:

We make every effort to compile accurate information for each participant. Occasionally, names may be misspelled if
participants speak too quickly or if there is an unclear connection.

Meeting View Leader Access:

To join the event:
https://meetingview.mymeetings.com/MeetingView/login.jsp?customHeader=mymeetings&sigKey=vcpdemo
Conference Number: 164XXXX

You may log onto Meeting View 20 minutes prior to the start of your conference.

For assistance contact your Meeting Manger.

A cancellation fee will be assessed per reserved line, in the event that the conference is not cancelled within 30 minutes
prior to the scheduled start time.

An overbooking fee will be assessed for each unused, reserved line after the first 50 unused lines, per completed
conference. There will be no fee assessed for the first 50 unused, reserved lines.

Leaders can schedule, modify or cancel a reservation by using the Conferencing Scheduling Assistant, an online
scheduling tool. To reschedule or cancel this reservation, go to
https://www.mymeetings.com/confassist/calist?customHeader=mymeetings&sigkey=vcpdemo.

For additional assistance, contact customer service at 800-475-5000

Special notes:

Call notes: JUN-24-13 01:22 PM/CT KRANIGM USA...this is for testing purposes only this call will not take place

The Conferencing Center would like to send you e-mail notes to keep you informed of new or enhanced products and
services, conferencing tips, or special offers, etc.

If you would prefer not to receive these messages, you may unsubscribe now at
https://www.mymeetings.com/custom/redirect.jsp?sigkey=vcpdemo&referer=/emeet/remove.jsp. Thank you.
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4. Do | need to download software to my PC to attend the Reserved Net Conference?

Yes, as you join a Reserved Net Conference, the Event Center Meeting Manager software will load on your PC.
If you wish to download the software prior to joining the call please go to the Plug-Ins page of My Meetings to
download the Event Center Meeting Manager software. You may also test that it loaded correctly by clicking on
the Setup link under the Event Center section.

Note: If you do not have administrative rights to your PC, the Event Center Meeting Manager software will need to be
downloaded by your company’s IT organization. They may obtain access to the software on the Plug-Ins page.

e Go to the Plug-Ins page on My Meetings:
0 https://www.mymeetings.com/emeet/join/src/plugins_mm.php?langKey=/en&sigKey=m
ymeetings
e  Scroll down to the WebEx Event Manager under the WebEx Plug-Ins section
e  Choose which version of the Event Center software to load on your PC based on your operating system
e  Click Setup which will launch you into a test Event Center session if the software load was successful

WebEx Plug-Ins |

+ WebEx Event Manager
To start or join an event you will need to download, install, and configure the
WebEx Event Manager. The first time you join or start an event, the Event Manager
will automatically be installed; however you can manually download it here.

Notes:
o 1f you are using a non-Windows or Macintosh operating system or browser
other than Internet Explorer or Firefox, a Java Client will be downloadad
automatically when you join an event. For more information, go to the EAQs.

© You must have administrator privileges on your computer to use this installer.

Download the installer for your operating system:
¢ Event Manager for Internet Explorer in Wind
® E Nag

° Event Center application for Mac OS X {Intel)

 in_ Windows

e Set up
Although WebEx Meeting Center will automatically be zet up when you host/join a
meeting, you can save time by setting up WebEx Meeting Center, on Windows or
Mac, before the meeting.

5. Where will | access the event?

e  Email invitation:
o Participants:
=  The Reserved Net Confirmation email will be sent to the leader of the event who will forward
the invitation to all participants. The participant link to the Reserved Net meeting will be
included in that invitation. Audio details will also be included for participants to dial into the
audio bridge.
0 Leaders:
= Leaders will log into their Manage My Meetings account to start their Reserved Net
Conference for Cisco WebEx Event Center meeting.
=  The Reserved Net meetings will be listed under the tab for Reserved Calls. See instructions
under the next My Meetings sub-bullet.

e My Meetings: The meeting link will also be listed on the leader's Manage My Meetings account on the
Reserved Calls tab
o Goto https://www.mymeetings.com/custom/site/mymeetings/index.jsp
o Enter your login and password. (Note: If you do not have a Manage My Meetings login and password,
Click on the Need to Register link and simply follow the instructions.)
o Select the Reserved Calls tab.
o Locate the appropriate confirmation number for the conference.
o Select the arrow icon to initiate the conference.

Note: You will need access to Manage My Meetings to use Reserved Net Conference with Cisco WebEx Event
Center. If you do not have access to Manage My Meeting, you should continue to use Reserved Net Conference
with Microsoft Live Meeting for the short term.
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6. Is there a cancellation policy?

e Yes, Reserved Net calls may be cancelled up to 30 minutes before the event without incurring a cancellation
fee. If canceled within 30 minutes of the scheduled start time, a cancellation fee may be assessed.

7. Can my call be recorded?

e Yes, you may request the call to be recorded. For each call that is recorded, there is a setup fee that
includes storage of the recording for 30 days. If you'd like to maintain the availability of the recording after
this time, there is extra charge for each additional 30 day period.

The Net Replay will be available after the call via the link included in the Reserved Net email confirmation.

e You may also request an FTP File Download of the recording for an additional fee. The link to the FTP File
download will be included in an email sent to you after your call.

8. Is software required to view the replay of the meeting?

e Yes, the replay and the FTP file Download are both available in an Advanced Recording File (ARF) format
and require the WebEx Recording Player to be viewed. The Player is available from the Conferencing portal
under Leader Tools and then Net Conferencing Plug-Ins.
https://www.mymeetings.com/emeet/join/src/plugins_mm.php?sigKkey=mymeetings

9. How do I retrieve the recorded file from my Reserved Net call?

e  The host of the call will receive the below email
e  The “From” field will come from the person who hosted the meeting.

NoflephesPlease Srymee Qs com Cmessonger Perbex (om > Sent Fn 172720151110 AM
worsck, Derre £

Iratructiont fer downloading the WebEs FTP recording TANWISHE140. 20141211 2151.1°

Please foliow the instructions below to download the FTP recording from your recent WebEx Reserved Net conference.
RWXWH808140-20141211 2151-1

December 11, 2014, 3:51 pm Chicago Time

33 mins

DOWNLOAD INSTRUCTIONS:

1. Click on the link below, or if your email program does not allow linking, copy and paste the link into the address field of yoor

2. Once you have been redrected to the Downlodd page, select the “Download™ button,

3. When given the option to "Open” or "Save” the file; select the arrow next to the “Save” button, then select "Save As”,
4. Once the “Save As” window appears, choose the location where you'd bke to save the FTP file and select the "Save” button.

** Please download your FTP recordng within 30 days of the date of this email, after that bme & will be deleted off the server and
no recording backup is maintained past this ime frame. **

If you need assistance, please contact us at the following email address: gmi-services@one yeriZon.com.

e  Click the link provided in the email as seen in the below screen shot.

want to share the following WebEx recording with you. Click the Tink below to play it:

?
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e You will be redirected to a page as seen in the below screen shot, that will provide them with the ability to
either Playback or Download the recording.

Note: If you choose to Playback the recording, you may still Download the recording at a later timeframe.

Recording Information

Topic:
Recording date:

PAR20120710 16131
Wedneaday, July 10. 2013 1113 am

Central Daybght Time (Chacago, GMT-05 )
Panelist Information
Duration: 5 menstes
Description:

ey

e  After selecting “Download” the following page will appear and you will have the ability to “Save” the file in a

location of their choosing.

Download file:P-20130710 1613-1
The recording file is ready for downloading now

If you do not have the ARF player installed,
you may click the “download” link to install it.

Note: The WebEx ARF player is required to playback the recording | Download ARF player |

L bkl

Close Window

File Download

X

Do you want to open o save this file?

0 Name: PWXWE063870-20130710 1613-1.aef

Type: ‘WebEx Player, 2.30M8

10

From: ntalwss.webex.com

[ Open || Save |[ Coxcet |

‘Whie fles from the Intemet can be usehu, some Bles can potentialy
haem your compater. If you do not trust the source, do not open o
save thes fle. What's the sgk?

10. How can | convert the recorded file to a different format?

e  The FTP recording will be downloaded in an Advanced Recording File (ARF) format that is WebEx
proprietary software which will require the user to install the WebEXx Player to view the recording.

e You may convert the recording to one of the following formats:
o WMV —Windows Media Video
o .SWF - Macromedia Flash Format
o .MP4 - MPEG Audio Layer

e Thisis a Real Time conversion process: A presentation with a duration of 1 hour and 15 minutes will take 1
hour and 15 minutes to convert.

e Inthe Network Recording Player select File
Select Convert Format
e  Select either WMV, SWF or MP4
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T Network Recording Player - Other Teleconference Test

View [Info Help
Open  CtrHO 76 | Date:Monday, August 15, 2011 | Time: 10:42 AM, Local Time (GMT -06:00)
| Convert Format WMV (Windows Media). ..
Close  Ctrl+w SWF (Flash)... Test
MPEG-4)...
Exit Ctr+Q Hp4 ¢ )
I Monday, August 15, 2011
Time: 10:42 AM, Local Time (GMT -06:00)

The Convert to window appears.
Select OK to proceed to start the conversion.

¥ Convert Format to WMV (Windows Media) | %]

Browse...
Video Codec
Wideo Codec: | Windows Media Video 9 [~]
Audo Codec
Audio Codec: | Windows Media Audio 9.2 [+]
Corversion Start Time

It may take a substantial amount of time and your computer resources to convert this file,
When do you plan to start the conversion?

% Convert now
" Convert at a scheduled time:

Peuelfo [EI[2 5] [1= TEHs 5

The conversion requires Windows Media Player 9.0 or above,

ok || concel

The below message will appear.

e Select OK and this message will disappear, leaving the conversion process to run in the back ground as you
work on other things.

%]

Network Recording Player

Conversion of "Other Teleconference Test-20110815 1542-1.arf" to "Other Teleconference Test-20110815 1542-1.wmv".
Double-click the Conversion Manager icon on the taskbar of your desktop to view information about and manage scheduled
recording conversions.

11



Reserved Net Conference with Cisco WebEx Event Center FAQ

e You may check the conversion progress by placing your mouse over the following icon in at bottom-right of
your screen (system tray):

== converting: 10% converted

SR LIRS

11. Is operator assistance available to me during my conference?

e Before the event:
e Yes, operator assisted services are listed under Net Feature Support on the scheduling systems.
0 This feature allows you to request a Net Conferencing Specialist to provide event support
services during a Net Conferencing session on your behalf.
0 An additional charge applies per session per Event Support service. Examples of Event
Support Services include:
e Video playback: Assistance and coordination of the video playback to allow the
audio to play through the audio conference.
e Advancing slides: Advancement of the slides on behalf of the leader.
e  Closed Captioning: Coordination of closed captioning for the event.

e During the event:
0 The operator will attend a Premier Level Audio conference for the entire time to attend to Q&A, or

address issues during the call.
o0 The leader will enter *0 to have the operator rejoin the audio conference to attend to an issue.

e  After the event:

0 Charges for Operator Hosting services will be included on your invoice for the call.

12. How many participants may | have for my event?

e Up to 3,000 participants (including the presenter and the event operator)are supported on Reserved Net
Conference for Cisco WebEx Event Center.

12
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13. What is the WebEx Event Center Leader Console?

The console is an easy interface that makes controlling a meeting very intuitive. Leaders can select to have
only those windows that are most important to them open during the meeting, showing the participants, chat,
notes, or video. Simple tabs make it easy to flip from presentation to presentation.

Toolbar Participant List Chat Recorder
[ Comce Webls Loumt Covtar - s
Qs et /
Topic: resnet W e
i L
! [alal -
- BT
1 vbex onlerers e 1wt s Remirad
B sheeryDesicp v

14. How do | ShareContent in the event?

A best practice for presenting content in a WebEx Event Center session is to use File Share.

| My Desktop  Ctrl+Alt+D

I Eile (Including Video)... I

Application »
Whiteboard Ctrl+Alt+N

Web Content...

Web Browser...
Multimedia...

My Event Window

File sharing is ideal for presenting information that you do not need to edit during the event, such as a video or slide
presentation. Participants can view shared files in their content viewers without the need for the application with which
it was created. They may view a media file, such as a video, without the need for special software or hardware. They
can also view any animation and transition effects on shared Microsoft ®PowerPoint ®slides. After an event starts, you
can open a presentation or document to share. You do not need to select it or loadit before the event. However a best
practice is to arrive to the call about 15 minutes before the call to initiate the File Share for any documents you intend
to share during the call. They will be arranged in folder across the top of your meeting for easy selection during the
call.

13
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While sharing a file, you can:
e  Draw on the screen
Use a pointer to emphasize text or graphics
Print it
Display it at various magnifications, in miniature (thumbnails), and in a full-screen view
Synchronize all participants' displays with the display in your content viewer
Save itto afile

At any time during a meeting, you can grant participants privileges that allow them to annotate, save, print, and
display different views of shared content.

Sharing a file
You can share a file, such as a document, presentation, or video that resides on your computer. Participants view
the shared file in their content viewers.

To share a document or presentation:
e  Onthe Share menu, choose File (Including video). The Share File dialog box appears.
e Select the file that you want to share.
e Click Open.

The shared file appears in the content viewer.

Tips for sharing files
These tips can help you share files more effectively.
e Toimport slide presentations quickly:

. Limit the number of animations and slide transitions.

e  Minimize the number of screen shots that you add to slides, especially bitmap graphics. Bitmaps
do not compress well.

e Toimprove the speed at which shared pages or slides appear in participant content viewers, save
the document or presentation as a .ucf (Universal Communications Format) file before the event
starts. Then share the .ucf file instead of the document or presentation itself.

e You can annotate shared presentations or documents in the content viewer; however, you cannot
edit them. If you want to edit shared information, you can use application sharing instead.

To save time during an event, begin sharing the document or presentation before the event's starting time. That
way, after participants join the event, they can begin viewing your presentation.

Choosing an import mode for presentation sharing
For Microsoft Windows ®users only

Before you share a presentation, you can choose one of the following import modes:

e Universal Communications Format (UCF)-The default mode. Allows you to display animations and
slide transitions in Microsoft PowerPoint presentations. In the UCF mode, Event Manager imports
presentations more quickly than it does in the printer driver mode. However, pages or slides may not
appear consistently in Event Manager across platforms.

e  Printer driver-Displays shared presentations as they appear when you print them, providing a
consistent appearance of pages and slides in Event Manager across platforms. However, this mode
does not support animations or slide transitions. In this mode, the first page or slide may appear quickly,
but the total import time for all pages or slides is usually longer than it is in the UCF mode.

Note: Changing the import mode does not affect any presentations that you are currently sharing. To apply a
new import mode to a shared presentation, you most close it first, and then share it again.

To choose an import mode for shared presentations:
¢ Inthe Event window, on the Event menu, choose Options. The Event Options dialog box appears,

with the Options tab selected by default.
e  Click the Import Mode tab.

14
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15
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PowerPoint(R) presentations
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jng, but displays p

animations and slide transitions

cancel |

e  Select either Universal Communications Format or Printer driver.

Closing shared

files

You can close any files that you are sharing in your content viewer.

To close a shared file:
¢ Inthe content viewer, select the tab for the file that you want to close.
e  On the File menu, choose Close.

If you have not yet saved any annotations that you made on the document or presentation, a message appears,

allowing you to save it.

15. What file types are supported for sharing in Cisco WebEx?

Please see below tor a listing of supported tile types:

Media Object

‘WebEx Recording
Audio

Video

'Yideo - QuickTime
movies

'Flash movies and
linteractive Flash

‘Web page

Supported Media Formats

WebEx Recording Format (WRF) |.wif

\Windows Media Audio
iAdvanr.Ed Streaming Format
:Audio for Windows (Waw)
Musical Instrument Digital
Interface (MIDI)

IMacintosh AIFF Resource
MP3 (MPEG Audio Layer)
\UNIX Audio

'Sound (SND)

:Audio Interchange File
Windows Media Video
Advanced Streaming Format

|audiofVideo Interleave (AVI)
|Moving Picture Experts Group
(MPEG)

Apple QuickTime

Macromedia Flash format

File Name
[Extensions

|- wma

|.way

|.mid, .midi

aif, .aiff

5_.rn_p2,_ mpv2, .mp3
‘:‘_au

|

'a‘&f’

Layi

[.mpg, .mpeg, .mlv,
MDA, .00
gDJ.DL gt

[.swef

'Any URL on the Intemet or your?Far example, .htm,

private intranet

|.asp, .php

Required Player
Built in
__Wir_sdaws Media Player

:Windows Media Player

lapple QuickTime Player
ffor Windows

Macromedia Flash Player

Intemet Explorer
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16. How do | share a video as a Presentation or Document?

17.

18.

In the meeting window, go to the Share menu, then select File (Including Video)....
The 'Share Document' window appears.

e Navigate to and select the file you would like to share in the meeting.
e  Click Open.
Notes:

A video file must buffer before it can play back.
It is recommended that the video file being shared is no larger than 5mb.

WebEx supports the following video formats as a Presentation or Document share:

flv (FLV files using the VP6 codec are not supported on SP22 or newer sites)
.swf
.asf
wmv
.avi
-mpg
.mpeg
.mlv
.mpa
.mpe
.wm

What is the Maximum Recommended Size for a Shared PowerPoint File?

For best results when sharing a PowerPoint file, refer to the following guidelines:

e Do not include more than 20 to 30 slides in one presentation file. If you want to share more slides,
create a separate presentation file for each set of 20 to 30 slides.
Keep the size of the presentation file to no more than 5 MB.
It is recommended to not share embedded media objects that are larger than 5MB.

Note: You may exceed the 5mb recommendation if the service type used has the ability to stream video files.

What is the best method to share a video file in a WebEx meeting?

Follow the steps below to stream a video file in a WebEx meeting:

e  On the Quick Start, click the Share File button.

. If the Quick Start is not visible, go to the Share menu, then select File (Including Video)

¢ Navigate to and select the video file you would like to share and then click the Open button.
e  The video will begin playing in the WebEx meeting.

Notes:

Recommended for sharing video files stored on your computer or a network location.
Starts playing for attendees instantly.

The following file types are supported with streaming video sharing:

WMV
WMA
WAV
.MP3
.ASF
AV
.MPG
.MPEG
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19.

20.

e MOV

e FLV (Video codec must be H.264, files using the VP6 codec will not playback properly)
e F4V

e QT*

o MP4*

*The computer sharing the video must be able to playback the file locally.

How do | share a video from a web site or web page?

Follow the steps below to share Web Content:

In the meeting window, go to the Share menu and then choose Web Content....

The 'Share Web Contents' window appears.

In the Address box, enter the address, or URL, at which the content resides.

Note: If you have previously shared the content, select it in the drop-down list.

In the Type: drop-down menu, select the type of Web content that you want to share.
Click the OK button.

e Tip: You can copy a URL from any source, such as another browser window, and then paste it in the
Address box.

Notes:
e  The video file must be on a publicly accessible web address and not password protected.
e Can also be used to display a web page that contains a video, such as YouTube.

Which Webcams are supported?

Camera hot-plugging is supported with WebEx HD/HQ video. This means cameras can be plugged in and
detected by WebEx during a live meeting.

IP or web-based cameras are not supported by WebEx. Virtual webcams such as YouCam, ManyCam and
WebCamSplitter are also not supported.

Webcams listed in Microsoft's Hardware Compatibility List (HCL) should work with any WebEx product that
supports video conferencing. If your device is not listed, it may not work with WebEXx.

Hi-Definition video is not yet supported in Event Center.

Cameras compatible with High Quality Video:

Manufacturer |Model

Cisco VT Camera I
Cisco VT Camera lll

Cisco

Tandberg

Tandberg Precision HD

Logitech Quick Cam Pro 9000
Logitech Quick Cam Orbit AF
Logitech Quick Cam C905
Logitech Quick Cam S7500
Logitech HD Pro Webcam C910

Microsoft LifeCam HD
Microsoft LifeCam VX-1000
Microsoft LifeCam Cinema
Microsoft LifeCam VX-6000
Microsoft LifeCam NX-6000
Microsoft LifeCam VX-3000

Logitech

Microsoft

Cameras compatible with Standard Quality video:

Most PC-compatible cameras should work with WebEx. The following cameras were tested by WebEXx:
e  Cisco VT Camera ll e  Creative WebCam Notebook
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Creative WebCam NX Ultra
Creative WebCam PRO

Ezpmocs EZCam USB Il

Logitech QuickCam - Notebooks Pro
Logitech QuickCam Zoom

Logitech QuickCam Express
Logitech ClickSmart 310

Logitech QuickCam pro 4000
Logitech QuickCam Messenger
Aiptek VGA+

SUMSUNG S-1298
SUMSUNG S-1288

Microsoft LifeCam NX-6000

21. Who can share their Webcam in an event?

22.

23.

24.

25.

Only the host, presenter or a panelist may broadcast their webcam video in an event.
By default, panelists cannot broadcast video in an event. The host must allow a panelist to send video

How Many Video Cameras can be displayed?

The number of video cameras that can be displayed in a session of Event Center is 1.

How does a panelist send video in an event?

The host of the call must follow the steps below to allow a panelist to send video:

In the Participant panel, place your mouse over the large video window, then click the E button.
The 'Panelist Video Options' window appears.

Go to the Allow to Send Video tab.

Check the boxes of the panelists you would like to send video, then click the OK button.

The selected panelists may now send video by clicking the button.

What are the bandwidth requirements for in-meeting video?

WebEXx generally recommends network bandwidth above 1Mbps per participant. A dual-core PC @ 2.0 GHz w/
1GB ram should be used. The minimum network bandwidth to view video should be above 320Kbps per
participant.

Standard WebEXx video generally requires bandwidth between 90-130Kbps per video participant at the default
configuration, which is QCIF resolution (176 x144 pixel) at 15fps.

Bandwidth requirements for High Quality (HQ) video are as follows:

High Quality - 360p (640x360) - Up to 1.5 Mbps of your internet connection will be used when sending video

Standard Quality - 180p (320x180) - Up to .5 Mbps of your internet connection will be used when sending
video.

Note: The figures above are only for webcam video and do not include any other in-meeting activities. You
will need to additional bandwidth to use desktop sharing, integrated VolP, etc.

Q&A

Questions can be answered publicly or privately in a Q&A session.

Providing a public answer to a question:

On your Q&A panel, go to the tab you received the question in, and click on the question.
A number will be displayed in the tab the question was received in.

T

[ | myoea(2

ul e |

Attendee 1 - 1:45 PMm
0: This is my question
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e«  Type your answer into the text box and click the Send button or press enter.
¢  The answer will appear on all panelists' and attendees' Q&A panel.

Providing a private answer to a question:
¢  Go to the tab the question was received in, and click on the question.

My Q&A (2)

Attendee 1 - 1:46 PM
0: This is my question
e  Type your response, and click the Send Privately... button.

e«  The answer will only be sent to the attendee that asked the question.

Responding to questions answered verbally:
¢ Right-click on the question in the Q&A panel.
e  Select Answered Verbally from the context menu.

Answering indicator
When a panelist is typing an answer to a question that hasn't been responded to yet, an in-progress indicator will
display below the question for all participants. See the example below:

Attendee 1 -3:23pM
(: Hi, I have another question
This question is being answered...

26. Saving a Q&A session

At any time during a session, you can save the questions and answers on the All tab on your Q & A panel to a .txt
or .csv file.

In the Session window, on the File menu, choose Save>Questions and Answers.

The Save Questions and Answers As dialog box appears.

Choose a location at which to save the file.

Type a name for the file.

In the Save as type box, select TextFiles(*.txt) or CSV (comma-separated/comma-delimited values).

Click Save.

27. Who can present during the Event?

Your event production team can be broken down into the following roles:

Role | Description

Host The participant who schedules, starts, manages, and ends the event and designates the presenter,
panelists, and polling coordinator.

The event host initially is the presenter. After the invited panelists join the event, the host can pass the
presenter control to any of the panelists at anytime during the event.

Presenter . ) [ ) ) ) .
The participant, with the presenter control symbol ,who is responsible for sharing and presenting

information during the event.

Panelist | A participant who is primarily responsible for assisting the presenter and participating in the presentation.

Attendee | A participant who mainly listens or watches and does not present information during the event.

28. What can each role perform during the event?

e Hosts can do the following:
A host is responsible for coordinating and controlling an event. Only one person can be an event host at
atime.
0 Schedule and start an event

19
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OO0O0OO0OO0OO0OO0OO0OOODOOO

Start and end a practice session among the panelists

Invite attendees to a scheduled event

Invite attendees to an event in progress

Grant privileges to attendees or panelists during an event
Designate a presenter

Assign the host role to another panelist, and reclaim the host role
Answer attendees' questions during a question-and-answer (Q & A) session
Restrict access to an event

Specify or edit a greeting or message for attendees during an event
Act as poll coordinator to start a poll

Pass the poll coordinator role to another panelist

Record an event

End an event

Note: Once an event starts, the host is initially the presenter as well. The host can then designate another
participant to be the presenter.

e Presenter can do the following:
An event host can designate any attendee as a presenter. A presenter is responsible for providing
content during an event.

O0OO0OO0OO0OO0OO0OO0OOOOOO

Documents, presentations, and whiteboards

Save documents, presentations, and whiteboards in the content viewer
Share applications, Web browsers, and desktops

Share multimedia Web content

Take a poll if the host passes the poll coordinator role to the presenter
Save a poll questionnaire and poll results to a file

Answer attendees' questions during a question-and-answer (Q & A) session
Send text responses to attendees' questions on the Q & A tab
Participate in a practice session

Participate in a chat

Save chat messages to a file

Save a Q & A session to a file

Record an event

e Panelists can do the following:
A host can designate any attendee as a panelist during an event. A panelist is a participant who is
primarily responsible for assisting the presenter and participating in presentation. Any number of
attendees can be panelists.

[eNoNoNeNoNoNe]

[cNeNeNeoNoNe]

Participate in discussions to which other attendees listen

Respond to public and private chat messages

Annotate shared documents

Start a poll if the host passes the poll coordinator role to the panelist
View and answer attendees' questions in a Q & A session

View poll results

Annotate shared applications, Web browsers, and desktops, if the presenter grants annotation
control to the panelist

Participate in a practice session

Save chat messages to a file

Download files that the presenter publishes

View live video that the presenter sends

View feedback

Record an event

e Attendees can do the following:
An event attendee participates in an event, but generally does not present information.

(cNoNeNeoNoNeNoNo)

View shared documents, presentations, and whiteboards in the content viewer
View shared applications, Web browsers, and desktops

View shared multimedia Web content

Participate in a poll

Participate in a chat

Save chat messages to a file

Download files that the presenter publishes

View live video that the presenter sends

e [f the event host or presenter grants the appropriate privileges to attendees, an attendee can also:

o
o
(o}

20

Annotate shared documents and presentations in the content viewer
Write and draw on shared whiteboards in the content viewer
Save documents, presentations, and whiteboards in the content viewer
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O Annotate shared applications, Web browsers, or desktops, if the presenter grants annotation
control to the attendee

O Copy and paste pages, slides, and whiteboards in the content viewer

0 Display different views of pages, slides, and whiteboards in the content viewer - for example, full-
screen view or thumbnail (miniature) view

O Print shared pages, slides, or whiteboards in the content viewer

O Record an event

e  Polling Coordinators can prepare a poll questionnaire and conduct a poll during the event.

29. How do | use Polling during an Event?

Polling enables the Leader to utilize the operator to survey all conference participants. You determine the
guestions prior to the conference and participants respond using their telephone keypads. Polling allows you to
collect instant feedback and increases participants’ involvement in the call. You receive a report with all
responses that is organized by question and participant. The poll coordinator is responsible for creating

and conducting the poll during the event. The host can assign the role of poll coordinator to a presenter or

a panelist.

How Do | Open a Poll
After you finish preparing a poll questionnaire, you can open the poll.
If you prepared your questionnaire in advance and saved it, you must first display it on the Polling panel.

In the event window, go to the View menu, then select Panels>Manage Panels....

The 'Manage Panels' window appears.

In the Available panels: section, select Polling, then click the Add >> button.

Click the OK button.

In the Question section in the Polling panel, select the type of question you would like to add, if the question
will have a single or multiple answer, then click the New button.

2]
Note: You may open a previously saved poll by clicking the I;I or button and selecting the poll.

e  Type out your questions and answers. Repeat to add multiple questions to the poll.
e  Click the Open Poll button.
¢ The questionnaire appears on attendees' Polling panels. Attendees can now answer the poll.
¢ As attendees answer the questions, you can watch the polling status on your Polling panel.
| Poling status

Mot started 4—2IAETN)

hpopes  _fodmn . Tlevaaae

Frohed S-S | hese thiee butions.

Remaning tene 454 Time et
e  Click Close Poll when the time is up.
e If you specify a timer and the poll times out, the poll automatically closes.
e« Attendees can no longer answer questions.
¢  Once you close a poll, you can view the poll results and optionally share them with attendees.

Preparing a Poll Questionnaire - Presenter only

To conduct a poll, you must first create a poll questionnaire. You create a questionnaire in a meeting. To save
time during a meeting, you can start the meeting earlier than the scheduled time, create a questionnaire on the
Polling panel, save it, and then open it during the actual meeting.

This figure shows a portion of the Polling panel, which offers the tools you can use to create a questionnaire.

Question
Type: (& Muiple choico 'Single Answer [+
" Short answer =
New | Change Type |

Arswer
LL00 )

Follow the steps below to create a questionnaire:
e  Open the Polling panel in a meeting.
e Inthe Question section, select one of these question types:
o To create a multiple-answer question, select Multiple choice, and then select Multiple Answers in the
drop-down list.
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o To create a single-answer question, select Multiple choice, and then select Single Answer in the drop-

down list.
o To create a text question, select Short answer.
Click New.

Type a question in the box that appears.

In the Answer section, click Add.

Type an answer in the box that appears.

To type another answer, click Add once you finish typing an answer.
The question and answers appear in the Poll Questions area.

This figure shows an example of a poll questionnaire.

Poll Questions:

1 What is your favorite color?
) ablue
O bred
O coreen
© d black

2What do you enjoy doing at letsure?
[ areading
[ b.watching movies
[ ¢ traveling
[ d.sports

3 Pleaze give us feedback about this event

Note: The character limit for the polling question & answer fields are 250 characters.

30. How do | end the Event?

e  The Host will End the Event by clicking on End Event under the File menu.

Open »

Save 4

Save s r

Transfer... Chr+T

rint v
| EndEvent
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31. How can | obtain a list of Participants who joined my Event?

The link to your Reserved Net participant listcan be found in the Reserved Net email confirmation.
However you may also follow the instructions below.

Log into Manage My Meetings

e Usethe Leader Tools and Self Service Reports link
o0 Click Leader Tools in your Manage My Meetings account and select Participant List

Reports

MyMeetings

Welcome to MyMeetings

~onferencing Solutions

Video Leader Tools

«Schedule a conference
+Join an event or RSVP to an event
*Subscribe to select conferenc

leaders

MyMeetings provides you with an easy way to

+Manage your conferences using tools built specifically for meeting

Access Account

Resources

Conference Scheduling

Conferencing Leader Toals

Note: Access to some tools req a

ssistant NEW!

* Manage My M

Manage My M

Qs is your online

update your profile

gs' account

porial. Here you can manage your scoount and subsaiptions, schedule conferences, and

o Enter the Conference ID or Meeting Number and click Proceed

Self-Service Report

subscription Meeting Number, then proceed

Conference ID or Meeting Number: 128

Contact Us | Manage My Meetings | Conferencing Home

For Reserved Net Conference, enter your Conference ID. For Instant Net Conference, enter your

23
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o0 Choose Participant List Reports

Self-Service Reports

2 Lakogacts Ll Begody

View your parbopant bsts rom your Net Conference of for any
Audo Web Streameng Auso Web Repliy of Net Replay
meetings Emad prot o s.ave these kats for your lurther
anatyus

0 Choose Net Conference and Click View Report

Participants List
Contact Us | Manage My Meetings | Conferencing Home

Note: You may format and analyze the entire data file by downloading the

:I?:Er:; separated (CSV) file to your local application (e.g. Excel, Lotus Select Report(s) To
[71 Net Conference

Conference ID 128 71 Net Replay

Leader: ASHI

Date/Time: JUL-28-2013 04:00 PM ET
Duration: 30 mins

Choose the report(s) that you wish to view.
'You may sort the entries by clicking on the column header

O Report will display the people who viewed your Net Conference.

Participants List

ContactUs | Manage My Meetings | Conferencing Home

Mote: You may format and analyze the entire data filz by downloading the Select Report{s)To | Download/Print your

comma separated (CSV) file to your local application (e.g. Excel, Lotus Display report

Notes). [¥1 Net Conference | &) caviextversion
[] NetReplay [ {3 printer Friendly

Conference ID 128 [meneead) |2 e

Leader: ASHE =

Date/Time: JUL-28-2013 04:00 PM ET

Duration: 30 mins

‘You may sort the entries by clicking on the column header
Net Conference Total F'amcipants 5

RS uAuE M_—

ASHE -UAT R VERIZON BUSINESS 07/28/2013 03:19 PM

ashe part R vzn 07/28/2013 03:20 PM @b com
ashe part2 R vzn 07/28/2013 03:21 PM  a@b com
ashe pat3 R vzn 07/28/2013 03:23 PM  a@b com
ashe pat3 R vZn 07/28/2013 03:42PM  2@b.co
Grand Total: §

Note: Participant list names will appear as entered by the participants when joining the conference.
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32. How can | obtain a list of Viewers who viewed the Replay of my meeting?

¢ Log into Manage My Meetings

e Click Leader Tools in your Manage My Meetings account and select Participant List Reports

MYMeeﬂngS Conferencing Solutions = E I l L K

¥

Home Audio Video Leader Tools Access Account

Welcome to MyMeetings

MyMeetings provides you with an easy way to

«Schedule a conference

+Join an event or RSVP to an event

*Subscribe to select conferencing senices

*Manage your conferences using tools built specifically for meeting
leaders

Resources Conference Scheduling

Conferencing Leader Tools

Note: Access to some tools requires a Manage My Meetings® account.

C

>ollaboration Plug-ins
Conference Scheduling Assistant NEW!

Meeting View

Mobile Conference Connection
Net Conferencing Plug-ins

Online Invoice Presentation (OLIP)

Web Moderator

FIIITIT

* Manage My Meetings is your online conference maintenance portal. Here you can manage your account and iptions, U and
update your profile.

e Enter the Conference ID or Meeting Number and click Proceed

Self-Service Report

Contact Us | Manage My Meetings | Conferencing Home

For Reserved Net Conference, enter your Conference ID. For Instant Net Conference, enter your
subscription Meeting Number, then proceed.

Conference ID or Meeting Number: 128
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e Choose Participant List Reports

:Self-Sem'ce Reports

1EAGO0acts List Regods

View your partiipant bsts from your Net Conference or for any
Audo Web Streaming Ao Web Replay or Net Replay
mettings Emad pret o save these kit for your futher
nalyus

e Choose Net Replay and Click View Report

Participants List
ContactUs | Manage My Meetings | Conferencing Home

Note: You may format and analyze the entire data file by downloading the

comma separated (CSV) file to your local application (e.g. Excel, Lotus

Notes). Select Report(s) To Downmdmrr:m your
i ?

Conference ID 128 @ Heio

[7] Net Replay

Leader: ASHI | View Report |
Date/Time: JUL-28-2013 04:00 PM ET
Duration: 30 mins

Choose the report(s) that you wish to view.
You may sort the entries by clicking on the column header.

e Report will display the people who viewed your Replay.

Participants List
Contact Us | Manage My Meetings | Conferencing Home

Note: You may format and analyze the entire data file by downloading the comma separated (CSV) file to your local application (e.g
Excel, Lotus Notes)

Conference ID 128

Leader: ASHE

Date/Time: JUL-28.2013 04:00 PM ET

Duration: 30 mins

You may sor the entries by clicking on the column header

Net Replay Total Participants: 1
Ashe R Vzn 07/29/2013 01:21 PM a@b com
Grand Total: 1

Note: Participant list names will appear as entered by the participants when joining the conference.
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